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What is Microsoft Word 2010? 

A word processing application that allows you to produce professional-

looking documents such as letters, resumes, reports, and more. 

 

Word is a program that Microsoft produces and it does cost money.  The 

Calcasieu Parish Public Library has Microsoft Word installed on all of the 

public Internet computers and the public can use it free of charge. Our 

computers still have Word 2007.  

 

Open Microsoft Word by double-clicking the icon that looks like this: 

If you have trouble double-clicking, click once on the icon and then press the 

Enter key to open the program. 

 

Let’s go over the parts of a Microsoft Word window. 
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1: File Menu 

(Backstage)  

Click the File button to view the Backstage menu. You can save, print, or 

share the file; modify Word options; and exit the program. 

2: Quick Access 

Toolbar 

This specialized toolbar provides quick access to the commands you use 

most often. 

3: Title Bar The name of the document will appear here, as well as the program name. 

4: Window Controls From left to right, these are Minimize, Maximize/Restore, and Close. 

5: Tabs Click a tab name to view commands specific to the tab name. For example, 

the Page Layout tab lets you change the paper size, margins, paragraph 

settings, and more. The command area under the tabs is known as the 

ribbon. 

6: Minimize the 

Ribbon and Help Icons 

 

7: Groups 

 

 

 

 

 

 

 
 

8: Working Area 

 

9: Scroll Bar 

 

 

 

 

 

 

 
 

 

10: Status Bar 

Click the small up arrow on the right-hand side of the window to hide the 

ribbon: 

 

The commands on each tab are separated into groups. In the picture on the 

previous page, the Paragraph group of the Home tab is highlighted. This 

group provides commands to change the size, look, and orientation of a 

paragraph. 

Sometimes, in the bottom right-hand corner of a group, you will see an 

option button. Click this button to see additional commands related to the 

group. 

 

Here is where you will type the contents of the document. 

 

The scroll bar lets you browse through your document. Click the up/down 

arrow at each end of the scroll bar to move in that direction, or click and 

drag the scroll marker to move quickly through the document. If your 

mouse is equipped with a wheel, rotate the wheel up or down to scroll.  

Also note that if you have zoomed into your document and the width of the 

page exceeds the width of the Word window, you will see a horizontal 

scroll bar appear just about the status bar. Use this to scroll from side to 

side. 

 

The status bar provides information about the document. It shows which 

page or pages are visible, how many words the document has, what view is 

currently being used, and the current zoom level. 
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If you’re uncertain of what a button does in Word, hover your cursor over it 

and a Screen Tip will pop up, telling you what the button does and the 

keyboard shortcut associated with it. Hover means to place your cursor over 

something, but not to click it. Go ahead and move your cursor around the 

screen and see if you can pull up some Screen Tips.  

 

Now that we are more familiar with the look of Word, let’s practice actually 

creating a document.  

 
Creating a Document  

When you open Word, it automatically starts a new, blank document for you 

and names it “Document1.”  

The new document should have a cursor flashing at the top. The cursor 

alerts you to where you are in the document.  If you start typing, the words 

appear where your cursor is located.  

 

Go ahead and type a sentence.  

Now click inside the sentence and add another word. Click after the 

sentence to move the cursor after the sentence.  

Move to a new line by pressing the Enter key (also called Return) and type a 

new sentence.  
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That’s all there is to it! Click and type and press Enter to move to a new line. 

However, if the sentence you’re typing is longer than the width of the page, 

Word wraps the text to the next line for you – you do not need to press 

Enter.   

There are several ways that you can delete text. The most common way is to 

use the Backspace key to remove items to the left of your cursor, or use the 

Delete key to remove items to the right of your cursor.  

Delete your second sentence using the Backspace key. 

Delete your first sentence using the Delete key. You’ll need to click with your 

cursor at the beginning of the sentence.  

Any questions about what we’ve done so far? 

Formatting a Document  
 

Microsoft Word defaults to Calibri font. Let’s practice changing the font to 

something else. 

You can use the drop-down menus in the Font group to control what font 

you’re using and the font size.  
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Click on the arrow next to the Font drop-down menu (it should say Calibri 

Body). You should see the fonts in alphabetical order. Scroll down through 

the menu and click on Cooper Black. Once you’ve clicked on it, you should 

see the words Cooper Black displayed in the drop-down menu now.  

Go ahead and type a sentence.  

 

 

 

 

 

Press the Enter key to move to a new line. 

Now let’s choose Times New Roman as our font. You can choose Times New 

Roman the same way you chose Cooper Black (by clicking on arrow on the 

drop-down menu and scrolling through) or you may click in the field of the 

drop-down menu and type in the words Times New Roman. There are 

multiple ways to change your font.  

Let’s also change the font size. The Font Size drop-down menu is next to the 

one we’ve been working with. Click on the arrow and change the font size to 

20. You should see 20 displayed in the menu now. 

Now type another sentence. See the difference font and font size can make?  
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We’ve learned how to make changes to text before we type it. We’re going 

to move onto making changes to text that has already been typed. 

Selecting Text of Entire Document 

Selecting text means you are highlighting or identifying text. Once you’ve 

highlighted the text, you can then make changes to it. We’re going to learn 

how to highlight the text of an entire document and how to select just a 

portion of a document.  

The keyboard shortcut Ctrl + A will select the text of an entire document. 

The way to do this is to hold down Ctrl (the Control key), tap the A key and 

let go.  

 

 

 

 

You should see all of your text highlighted in blue. This means you may now 

modify it. We’re going to practice bolding, italicizing, and underlining our 

text. 

 Bold, Italics and Underline 
 

 

 

 

Click on the B that is located underneath the Font drop-down menu. Our 

text is now bold. Click on the B again to un-bold the text.  

Click on the I located next to the B. Our text is now italicized. Click on the I 

again to un-italicize the text.  
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Click on the U located next to the I. Our text is now underlined. Click on the 

U again to take away the underlining.  

The changes we’ve made have been to the entire document because we had 

the entire text of the document selected. Now we’ll learn how to select just 

a portion of the text of a document for modification. 

Selecting Part of a Document 

Place your mouse to one end of the part of text you want to select. Then, 

hold down your left mouse button and drag your mouse over the text you 

want to select.  

Once you’ve completed these steps, the text will appear highlighted in blue, 

like this: 

 

Go ahead and select your first sentence. Now any changes we make will just 

affect the portion of text that we’ve selected. (Keep in mind this means if 

you hit a key on the keyboard, it will delete the text and replace it.) 

Can you change the font of the selected sentence? Can you change the font 

size to 26? Can you change it to a 10-point font size?  

Aligning Text 

Word aligns text to the left as a default.  

To align text to the right margin, click on the Align Text Right button.   
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To center text, click on the Center button. 

To return it to left align, click on the Align Text Left button.  

Changing Paragraph Spacing 

To change paragraph spacing, first place your cursor in the paragraph that 

you want to change. Then, click the Line and Paragraph Spacing button and 

choose your spacing. 

Or you may change the spacing of an entire document by selecting the 

entire text of a document using the keyboard shortcut Ctrl + A.  

 

You can also choose to add or remove spaces around paragraphs. This 

means, for example, that if after you press Enter when finishing a paragraph, 

space will be added to the end of the previous paragraph. If you click Line 

Spacing Options, the Paragraph dialog will open. 

Moving Text 

Now that you’ve got a good grasp on selecting text, let’s explore how to 

move text around. In this lesson, we’ll cover the staples for moving text: cut, 

copy, and paste; drag and drop. 
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Cutting, Copying, and Pasting Text 

Cut, copy, and paste are fundamental skills. Cutting removes the text from 

one location while copying makes a duplicate of the text. Cut and copy put 

the text on a clipboard. Pasting involves relocating the text you’ve cut or 

copied from the clipboard to a desired location.   

Select the text you want to move – let’s move our first sentence. Now click 

the Cut button which looks like a pair of scissors in the upper left corner of 

the screen.  

 

 

 

Move your cursor and click at the end of the second sentence you wrote.  

Click the Paste button which looks like a clipboard. 

The sentence you cut should appear 
at the end of the second sentence.  
You’ve cut and pasted! 
 
 
Copy and paste is similar to cut and paste, 
but instead of removing text and relocating it, you are making a copy of 
something and adding it to your document.  
 
Select the text you want to move. Choose either sentence you’ve typed. 
Click the Copy button which is in the same area as the Cut and Paste 
buttons. It looks like two sheets of paper. 
 
Click your cursor where you would like  
your copied sentence to go. Now click  
the Paste button. You should see a  
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copy of your sentence appear. 
 
You can continue clicking the Paste button and it will keep pasting the  
sentence as many times as you want. 
 

You can copy text from other sources, like an email or website and 

incorporate it into your document.  

The cut, copy and paste actions can also be performed by right-clicking and 

using the context menus.  

Dragging and Dropping Text 

Word lets you drag text around in your document. Select the text first. Then 

click and hold the left mouse button on the text and drag the text where you 

want it. 

When you’ve reached your location, release the mouse button. The text will 

look just like it’s been cut and pasted (you will even have paste options), but 

in some instances the operation is quicker. 

Go ahead and select one of your sentences and try to drag and drop it 

elsewhere in your document.  

 

 

Using Undo and Redo 

You will find the Undo and Redo commands on the Quick Access toolbar: 

 

Undo undoes the previous actions in sequential order. Redo redoes previous 

actions in sequential order.  
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Click behind the sentence you’ve dragged and dropped and type a new  

sentence: I am learning to use Undo and Redo.  

Now click the Undo button  (the arrow pointing to the left.) It will undo 

your typing.  

Now click the Redo button         (the arrow pointing to the right.) It will redo 

your typing.  

Note that you will not be able to use the Redo button until you have used 

the Undo button – there is no redoing anything until you have undone 

something.  

You can press the Undo button multiple times to undo actions in backwards 

order. You can also click the down arrow beside the Undo button to reverse 

several actions.  

Working with Your Document 
  

So far, you have learned how to create a document. However, you won’t be 

able to create documents from scratch forever – that’s really not practical! 

Let’s move on and take a look at how to open, save, close, and work with 

Word documents. 

Saving Files 

It’s important to periodically save your work so that you won’t lose it. Word 

does have a safety net in place in case something happens (like your 

electricity suddenly goes out and your computer shuts off in the middle of 

you working on an important document), but it’s better to save your work 

than to count on Word’s auto save feature.  

To save a file for the first time, you can click the Save icon ( ) on the Quick 

Access toolbar, press Ctrl + S, click File  Save, or click File  Save As. Any 

of these options will open the Save As dialog. 
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Next, you can choose a location to save your file. At the bottom of the 

window, enter a file name. (You can also choose a file type, but for now, we 

will stick with the default Word document type.) Click Save. 

 

 

 

 

 

 

 

 

 

 

 

 

Go ahead and name your file and save it to the Desktop. Once you’ve done 

this, you should see the name at the top of your screen change from 

Document1 to the file name you’ve chosen.  

Keep in mind that Save As allows you to create a new file. You are naming it 

and choosing where you want it to be saved. Once you’ve saved a file this 

way, you can now simply use Save to update the file with any changes 

you’ve made to it. Save As creates a new file, Save updates an already 

existing file with changes.  
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You can save your documents to your computer (like we’re doing now) or 

you can save them to a flash drive if you want them to be portable.   

Exit out of Word by using the Close button (the X in the upper-right corner). 

It’s ok to do this because we’ve saved a copy of our work!  

Opening Files 

There are a few ways to open Word documents. The first way we’ll cover is 

finding the file and double-clicking it.  

Let’s find our saved document on the Desktop and open it up. You can open 

the file by double-clicking, or, if you have trouble double-clicking, you may 

single click and then press the Enter key, or right-click and choose Open 

from the menu.  

 

Once you’ve opened the file, go ahead and close Word again. This time let’s 

close it a different way. Click on File and then click Exit on the left-hand side.  

Open Word again and this time let’s launch it from the Start menu. Click on 

the Start button and click on Microsoft Word in the menu that appears. 

There are multiple ways to open and close programs and files. It’s good to 

know them, but using the one that is easiest for you is just fine.  

Let’s open our document again using a different technique. Click File and 

then Open on the left-hand side. In the dialog box that appears select a 

location from the top or the pane on the left, click a document to select it, 

and then click Open. The file will then open. 

Another way that you can open files is with the Recent item in the File 

menu. If you click File, then Recent, you will see a list of recently opened 

documents and the locations where those documents can be found: 
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You can click any document to open it or click any folder to open that folder 

in the Open dialog box. 

See if you can open a file using the Recent option. Once you’ve opened a 

file, close it.  

Ok, now that we’re comfortable with opening files, let’s see if you can open 

the file entitled “Spell Check Practice.” Use the File  Open technique. The 

file is located in Documents.  

Review 
 

The first section of the Review tab is the one you will probably use the most: 

 

 

This contains commands to check spelling, perform research, look up words 

in the thesaurus, and perform a word count. 
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Spelling & Grammar  

Microsoft Word will check spelling and grammar for you. 

 It will underline any misspelled words in red. Missspelling.  

It will underline any grammar issues in green. Grammar issue.  

These lines will not actually appear when you print.  

Let’s perform a spelling and grammar check on the document we have 

opened. Click on the Review tab, and then click on the Spelling & Grammar 

command.  

 

 

 

 

 

 

 

The first error it finds is a spelling error. Click Ignore to do nothing to the 

misspelling. Click Change to replace the misspelling with the suggestion. If 

there’s more than one suggestion, click on the correct one and then click 

Change.  

Proceed through each error and opt to change or ignore the items Word 

thinks are incorrect. After Word has covered each item, click OK to complete 

the Spelling and Grammar check. 
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Setting Up Your Page 

Before you print something, you should make sure that the page is laid out 

the way you want. Click the Page Layout tab and look at the first three 

commands in the Page Setup group: 

 

 

 

Margins 

Margins are the white space around the page’s edges. To change the 
margins, click the Margins button on the Page Setup group and pick a preset 
size or enter in a custom size. 

Changing Page Orientation 

Page orientation refers to how the text is laid out on the page. 

 

 

 

 

As you can see, with portrait orientation the paper would be printed on with 

the long side vertically. With landscape orientation, the paper would be 

printed on with the long side horizontally. 

To change your document’s orientation, click the Orientation button on the 

Page Setup group and choose either portrait or landscape. 

Setting Paper Size 

Typically, you will be using Word’s default paper size: 8 ½ by 11 inches, 

called letter size. If you want to change this, however, you can do so using 
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the Size command. Simply click the Size button on the Page Setup group and 

click the size that you want. 

Printing and Viewing Your Document 

 

Now that we’ve gotten our document proofed, it’s ready to print!  

Print Preview 

When you open the Print options by clicking File  Print, you will see a 

preview of what your document will look like on the right-hand side of the 

screen: 

 

 

 

 

 

 

 
This view provides a scaled-down version of what your document would 
look like if it were printed as is. You can flip through the pages or zoom in 
and out by using the tools at the bottom of the screen. 

Using Basic Print Options 

Open the Print options by clicking File  Print: 

If you have a printer installed and turned on, and paper ready to go, just 

click the Print button.  

To select a different printer, click the pull-down arrow under the Printer 

heading and make a selection: 
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Under the Settings heading, there are a few more basic commands. If you 

click Print All Pages, you will have a choice over which pages in the 

document will be printed: 
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Look at the top four options:  

Print All Pages Prints the entire Word document, including blank pages. 

Print Selection If you selected a certain part of your document (text, images, tables, etc.) 

click this command to print only the selection. 

Print Current Page Word will print whatever page your cursor is in. 

Print Custom Range You can define a range of pages to print. This option is also available just 

under the Print All Pages command. 

 

 

 

 

 

 

 

 

Print One Sided 

 

 

 

 

 

 

 

Print on one side of the page or receive instructions to print on both sides 

of the page (called duplex printing). 

Collated If you have a 3 page document and wanted to print 2 copies, the pages 

would come out 1, 2, 3, 1, 2, 3. 

If you printed uncollated, the pages would print 1, 1, 2, 2, 3, 3. 

Portrait Orientation Change the page orientation from portrait to landscape.  

Letter Change the paper size.  

Normal Margins Change the page margins.  
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1 Page Per Sheet You can print thumbnail images of your document. You can print 1, 2, 4, 

6, 8, or 16 pages per sheet of paper. 

Adding Clip Art 
 

Word allows you to add images to your documents. This function is located 

in the Insert tab.   

Clip Art are ready-made illustrations, movies, and sounds you can use in 

your documents. Microsoft has a large variety of these for you to use.  

Click on the Insert tab, then click the Clip Art button.  

Type food in the search box and click “Go” or press the Enter key.  

Click on an image to insert it into your document.  

 

 

 

 

 

 

 

 

There are small blue bubbles at the corners and middle of the picture. When 

you move your cursor over these areas, it turns into a two-headed arrow. 

This means you can modify the size of the picture.  
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Practice resizing the picture (enlarging and shrinking) by clicking and 

dragging with the two-headed arrow.  

You can also add your own pictures into your document. Instead of clicking 

the Clip Art button, click on the Picture button next to it. You can choose a 

photo saved on your computer or from a flash drive or memory card.  

See if you can add an image to your document using the Picture button.  

Keyboard Shortcuts 

There are hundreds of shortcuts in Word, but here’s a list of the most 

common ones: 

Open a new document Ctrl + N 

Save a file Ctrl + S 

Open a file Ctrl + O 

Print a document Ctrl + P 

Close Word Alt + F4 

Select All Ctrl + A 

Copy text Ctrl + C 

Cut text Ctrl + X 

Paste text Ctrl + V 

Find text Ctrl + F 

Align text to center Ctrl + E 
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Align text to left Ctrl + L 

Align text to right Ctrl + R 

Justify text Ctrl + J 

Increase font size Ctrl + Shift + . 

Increase font size Ctrl + Shift + , 

Undo last action Ctrl + Z 

Redo last action Ctrl + Y 

Check spelling or grammar F7 

Get Help F1 

 

 

Creating New Documents 
 

Earlier we saw that when you open Word, it creates a new document and 

names it Document1 (visible on the title bar):  
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If you want to create another new document, click File, then New. This will 

open a list of available templates.  

 

 

 

 

 

 

 

 

 

 

Blank Document is the default template and this creates another blank 

Word document. You can browse through the categories listed below to find 

other templates.  

Let’s practice opening a Resume template.  

Double-click on Resumes and CVs. Open the Basic Resumes folder. Double-

click on a resume template to open it.  

You can search for more templates using the search box.  
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Practice  

 
Open the file located in Documents named Spacing Practice. 

Double space the document. (Hint: you’ll need to select all of the text.) 

Change the spacing back to single spaced.  

Change the orientation of the page from Portrait to Landscape.  

Close the document without saving (Hint: click File, then close.) 

 
Open the file named Formatting Practice.  

Change the font of the first paragraph to 25-point Arial.  

Center the all of the text. 

Italicize the second paragraph. 

Move the third paragraph to the beginning of the document by cutting and 

pasting it. 

Close the document without saving. 

 
Open the file named Clip Art Practice.  

Insert a picture of black cat.  

Increase the size of the picture until it’s at least double in size. 

Save a copy of the document to the Desktop with the name Black Cat.  

Exit Word. 

 
Further Resources 

If you have access to the Internet, you can check out the basics of Word and 

learn about new features by using a command in the Backstage menu. 

To do this, click File  Help  Getting Started: 
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A new Web page will open in your default browser and direct you to articles 

about what’s new and how users of Word 2003 (and earlier) can get up to 

speed with the new interface. 

The library has books and DVDs on Microsoft Word that you can check out 

from the library. 

We have software tutorials online as well. You can practice with these in the 

library of access them from your home computer.  

 Go to calcasieulibrary.org 

 Click on Resources 

 Click on Job & Careers 

 Click on Learning Express Library (if you’re accessing it from home, put 

in your library card number at this point) 

 Click on Popular Software Tutorials 

Any questions? 


